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Introduction to OnCommand Guide to Common
Workflows

This guide provides workflows for tasks that enable you to achieve the common administrative goals
that form the basis for OnCommand. This guide is not comprehensive, but it does provide examples
of the most common tasks that administrators perform.

This guide is intended for experienced storage and virtual infrastructure administrators. It includes
administrative tasks that span multiple user interfaces that launch from a single user interface: the
OnCommand console.

Completing tasks in this guide requires that you have both the OnCommand console and all host
services installed and configured on your system. See the OnCommand Installation and Setup Guide
for more information.

You can also use the appendix included in this guide as a source for background information about
the guidelines and decisions that precede each workflow.

Related information

OnCommand Installation and Setup Guide - http://now.netapp.com/NOW/
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Backing up physical storage objects

This workflow shows you how to create a backup of your physical storage objects by creating a new
dataset and then assigning an existing protection policy and weekly backup schedule, using both the
OnCommand console and the NetApp Management Console.

Before you begin

You must have installed the OnCommand console and NetApp Management Console.

You must be familiar with the protection concepts of a dataset, protection policy, and backup
schedule. For more information on these concepts, see the OnCommand console Help.

About this task

This workflow is based on the assumption that you start in the OnCommand console and that you are
creating an empty dataset and assigning an existing protection policy and weekly backup schedule as
separate steps. You can also assign policies and backup schedules during the creation of the dataset.

During this task, the OnCommand console launches NetApp Management Console. Depending on
your browser configuration, you can return to the OnCommand console by using the Alt-Tab key
combination or clicking the OnCommand console browser tab. After the completion of this task, you
can leave the NetApp Management Console open, or you can close it to conserve bandwidth.

After you finish

After you have completed the tasks involved in creating a dataset, including assigning a local policy
and storage service, you can perform an on-demand backup to ensure that no problems exist with the
dataset configuration. For more information on how to perform an on-demand backup, see the
OnCommand console Help.

Steps

1. Add a new dataset of physical storage objects on page 8
Creating a new dataset enables you to group and manage physical storage objects that share the
same protection requirements. After creating a dataset, you must assign an existing protection
policy.

2. Assign a protection policy to the new dataset on page 9
Assigning a protection policy to your new dataset enables you to specify how you want your data
to be protected. This includes how you want to protect the dataset on primary, secondary, or
tertiary storage; schedule backups; and retain backups. After assigning a protection policy, you
can add a weekly backup schedule that is applied to your protection policy.

3. Add a weekly protection schedule on page 10
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Adding a weekly protection schedule enables you to specify times for backup and mirror
operations and lets you run existing daily schedules on specific days of the week. You can also
designate backups to retain as weekly copies based on the protection policy settings.

Adding a dataset of physical storage objects
You can use the Add Dataset wizard to add a dataset to manage protection for physical storage
objects sharing the same protection requirements, or to manage provisioning for the dataset members.

Before you begin

• You must already be familiar with the Decisions to make before adding datasets of physical
storage objects (for protection) on page 61.

• You must have NetApp Management Console installed.
• You must have gathered the protection information that you need to complete this task:

• Dataset properties
• Dataset naming properties
• Group membership

• You must have gathered the provisioning information that you need to complete this task:

• Provisioning policy for primary node
• Migration capability
• vFiler unit assignment
• Provisioning policy for nonprimary dataset nodes

• You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

During this task, the OnCommand console launches NetApp Management Console. Depending on
your browser configuration, you can return to the OnCommand console by using the Alt-Tab key
combination or clicking the OnCommand console browser tab. After the completion of this task, you
can leave the NetApp Management Console open, or you can close it to conserve bandwidth.

Steps

1. Click the View menu and select the Datasets option.

2. In the Datasets tab, click Create and select the Dataset with storage objects option to start the
NetApp Management Console Add Dataset wizard.

3. Complete the steps in the Add Dataset wizard to create a dataset of physical storage objects.

After you complete the wizard, the new dataset is listed in the Datasets tab.
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4. To provide data protection or disaster recovery protection for the new dataset, select that dataset
and click Protection Policy to start the Dataset Policy Change wizard.

5. When finished, press Alt-Tab or click the OnCommand console browser tab to return to the
OnCommand console.

Related references

Administrator roles and capabilities on page 55

Assigning or changing a protection policy
You can assign a policy to a dataset or change the policy assigned to it. The policy specifies how the
data is to be protected.

Before you begin

• You must have gathered the protection information that you need to complete this task:

• Dataset properties
• Group membership
• Protection policy

• Determine which policy you want to assign to the dataset. You can review available protection
policies on the Protection Policies window. If no policy meets the requirements of your new
dataset, you can create a new policy or modify a copy of an existing policy.

• You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

• You can use this procedure after you have created a new dataset and want to assign a policy to it,
or when you want to change the protection policy assigned to a dataset. You can also use this
procedure to protect a dataset that is listed on the Datasets window

• The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Any dataset that you directly assign a protection policy or provisioning policies and resource
pools directly through NetApp Management Console is displayed as a dataset of physical storage
objects.

Steps

1. From the NetApp Management Console navigation pane, click Data > Datasets > Overview.

2. Select a dataset and click Protection Policy to start the Dataset Policy Change wizard.
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If you want to provision your nodes by resource pool, click the Provision and attach resources
using a policy option when it is displayed.

3. Complete the steps in the wizard.

Related concepts

Decisions to make before assigning or changing policies on page 64

Related references

Administrator roles and capabilities on page 55

Adding a weekly protection schedule
You can use the Add Schedule wizard to create new weekly protection schedules. After you create a
weekly schedule, you can apply it to protection policies to determine when hourly, daily, and weekly
backup or mirror operations are executed.

Before you begin

Have the information available that you need to complete this task:

• Days and time to perform the mirror or backup operation and how often (required)
• Retention time of mirror or backup copies (optional)
• Throttle schedule (optional)

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

Steps

1. From the NetApp Management Console navigation pane, click Policies > Protection >
Schedules.

2. Click Add to start the Add Schedule wizard.

3. In the wizard, select the Weekly schedule option and complete the wizard to create the new
Weekly schedule.

If you do not want to schedule weekly backups, continue past the Weekly Events property sheet
without specifying a day or time.

Result

Your new schedule is listed on the Schedules tab.
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Related concepts

Decisions to make before adding a schedule on page 59

Related references

Administrator roles and capabilities on page 55
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Backing up unprotected physical storage objects

This workflow shows you how to create a backup for unprotected data. You can identify unprotected
volumes, add them to an existing dataset, and schedule backups using both the OnCommand console
and the NetApp Management Console.

Before you begin

You must have installed the OnCommand console and NetApp Management Console.

You must be familiar with the protection concepts of a dataset, protection policy, and backup
schedule. For more information on these concepts, see the OnCommand console Help.

About this task

This workflow is based on the assumption that you start in OnCommand console.

During this task, the OnCommand console launches NetApp Management Console. Depending on
your browser configuration, you can return to the OnCommand console by using the Alt-Tab key
combination or clicking the OnCommand console browser tab. After the completion of this task, you
can leave the NetApp Management Console open, or you can close it to conserve bandwidth.

After you finish

After you have completed the tasks involved in creating a dataset, including assigning a local policy
and storage service, you can perform an on-demand backup to ensure that no problems exist with the
dataset configuration. For more information on how to perform an on-demand backup, see the
OnCommand console Help.

Steps

1. Identify unprotected physical storage objects on page 14
Identifying unprotected physical storage objects in the OnCommand console enables you to add
them to an existing dataset in NetApp Management Console .

2. Add unprotected data to an existing dataset on page 14
Adding unprotected data to an existing dataset in NetApp Management Console enables you to
protect that data and change protection policies based on your requirements.
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Identifying unprotected physical storage objects
You can locate your unprotected physical storage objects so that you can add them to existing
datasets or to create a new dataset for the purpose of protection.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

About this task

During this task, the OnCommand console launches NetApp Management Console. Depending on
your browser configuration, you can return to the OnCommand console by using the Alt-Tab key
combination or clicking the OnCommand console browser tab. After the completion of this task, you
can leave the NetApp Management Console open, or you can close it to conserve bandwidth.

Steps

1. If the Dashboard is not visible, click the Dashboard tab.

2. Locate the Unprotected Data dashboard panel.

3. Click Volumes.

OnCommand takes you to the NetApp Management Console Unprotected Data window.

Related references

Administrator roles and capabilities on page 55

Adding unprotected data to an existing dataset
You can add unprotected data to an existing dataset, even if the dataset is currently unprotected. You
can browse and add an entire host, or individual aggregates, volumes, qtrees, virtual machines, or
Open Systems SnapVault directories on the host.

Before you begin

• Determine the name of the dataset to which you want to add the resource.
• You must be authorized to perform all the steps of this task; your RBAC administrator can

confirm your authorization in advance.
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About this task

• When you add an unprotected qtree or volume to a dataset that has an assigned protection policy,
the NetApp Management Console data protection capability starts an initial baseline transfer of
the data from the primary to the secondary node of the dataset.

Note: An initial baseline transfer of existing qtree or volume data might require many times
more bandwidth and time than subsequent incremental transfers of that data will require.

• If you add an unprotected resource to a dataset that does not have an assigned protection policy,
the data is unprotected until you assign a protection policy to the dataset and the dataset conforms
to that policy.

• The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.

Steps

1. From the NetApp Management Console navigation pane, click Data > Unprotected Data >
Resources.

2. Select the resource that you want to add to a dataset:

a. Select one or more hosts that contain the data that you want to protect.

The aggregates, volumes, and qtrees contained in that host are displayed in the bottom left
pane, in a hierarchical list.

b. (Optional) Use the View Resources buttons to select which resource type to display, then
select the specific aggregates, volumes, qtrees, hosts, or Open Systems SnapVault directories
that contain the unprotected data that you want to add to a dataset.

3. Click Add to existing Dataset. 

A dialog box opens, from which you can select an existing dataset. This list includes both
protected and unprotected datasets.

4. Verify that the existing dataset contains the new resource by viewing the dataset member list in
the Datasets window Overview tab.

Result

The qtrees, volumes, aggregates, or hosts that you added to the dataset are displayed in the Datasets
window and are no longer displayed in the hierarchy or host lists in the Unprotected Data
window Resources tab.

After you finish

To protect the data in the dataset, you must assign a protection policy to the dataset.
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Related references

Administrator roles and capabilities on page 55
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Backing up Hyper-V virtual objects

This workflow shows you how to create a backup of your Hyper-V virtual storage objects by creating
a dataset and assigning a local policy and storage service, using the OnCommand console.

Before you begin

You must have installed the OnCommand console.

You must be familiar with the protection concepts of a dataset, protection policy, and backup
schedule. For more information on these concepts, see the OnCommand console Help.

About this task

This workflow is based on the assumption that you use OnCommand console to create the backup
and that you use an existing local policy and storage service.

After you finish

After you have completed the tasks involved in creating a dataset, including assigning a local policy
and storage service, you can perform an on-demand backup to ensure that no problems exist with the
dataset configuration. For more information on how to perform an on-demand backup, see the
OnCommand console Help.

Adding a dataset of virtual objects
The OnCommand console enables you to create datasets to manage the protection and provisioning
of virtual objects in VMware or Hyper-V environments.

Before you begin

• Review the Guidelines for adding a dataset of virtual objects on page 66.
• Review the Requirements and restrictions when adding a dataset of virtual objects on page 71
• Review the Best practices when adding or editing a dataset of virtual objects on page 56

• Have the protection information available that you need to complete this task:

• The type of virtual objects, either VMware objects or Hyper-V objects, that you want to
include

• The name you want to give this dataset
• The user group to whom you want this dataset visible
• Whether you want to specify dataset-level custom naming formats for the Snapshot copy,

volume, and qtree objects that are generated by local policy or storage service protection jobs
on the virtual objects in this dataset
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• You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

The Create Dataset dialog box allows you to create an empty dataset, a populated but unprotected
dataset, a populated, remotely protected dataset, a populated locally protected dataset, or a populated
partially-configured or fully-configured dataset. A minimally configured dataset is an empty dataset.

Datasets of virtual objects must have any secondary protection and provisioning configured through a
storage service that you assign to them using the OnCommand console.

Steps

1. Click the View menu and click the Datasets option.

2. In the Datasets tab, click Create and select the option for the appropriate virtual object dataset
type.

• To create a dataset to manage VMware objects, select the Dataset with VMware objects
option.

• To create a dataset to manage Hyper-V objects, select the Dataset with Hyper-V objects
option.

3. In the Create Dataset dialog box, select the Name option and enter the requested information in
the sub-tabs of the associated content area.

a. Enter the dataset name and administrative contact information in the General Properties tab.

b. If you want to specify dataset-level naming formats to apply to the Snapshot copy, volume,
and qtree objects that are generated by local policy or storage service protection jobs that are
run on this dataset, select options in the Naming Properties tab.

4. If you want to specify, at this time, the virtual objects to include in this dataset, select the Data
option and make your selections in the associated content area.

You can also add or change this information for this dataset at a later time.

5. If you want to specify, at this time, a storage service that will execute remote protection for the
objects in this dataset, select the Storage service option and make your selection.

You can also add or change this information for this dataset at a later time; however, changing
this information later, requires more time.

6. If you want to specify or create and configure, at this time, a local policy that will execute local
protection for the objects in this dataset, select the Local Policy option and make your local
policy selection or configuration.

You can also add or change this information for this dataset at a later time.
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7. After you specify your desired information, if you want to test whether your dataset's new
configuration is in conformance with the OnCommand console requirements before you apply
them, click Test Conformance to display the Dataset Conformance Report.

• If the Dataset Conformance Report displays no warning or error information, click Close and
continue.

• If the Dataset Conformance Report displays warning or error information, read the Action and
Suggestion information resolve the conformance issue, then click Close and continue.

8. Click OK.

The OnCommand console creates your new dataset and lists it in the Datasets tab.

Related references

Administrator roles and capabilities on page 55
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Backing up VMware objects

This workflow shows you how to create a backup of your virtual storage objects by creating a dataset
and assigning a local policy and storage service, using OnCommand Plug-in for VMware.

Before you begin

You must have installed and logged into the following software:

• OnCommand console
• OnCommand Plug-in for VMware
• DataFabric Manager server
• vSphere Client

You must be familiar with the protection concepts of a dataset, protection policy, and backup
schedule. For more information on these concepts, see the OnCommand console Help.

About this task

This workflow is based on the assumption that you use OnCommand Plug-in for VMware to create
the backup and that you use an existing local policy and storage service.

After you finish

After you have completed the tasks involved in creating a dataset, including assigning a local policy
and storage service, you can perform an on-demand backup to ensure that no problems exist with the
dataset configuration. For more information on how to perform an on-demand backup, see the
OnCommand console Help.

Creating a dataset
You can create datasets to manage the protection of virtual objects in a VMware environment. A
dataset is a set of virtual data storage containers that you can configure as a unit for the purpose of
group protection operations, like having multiple backup schedules for members in a dataset.

Before you begin

Have the following protection information available:

• The name you want to give this dataset
• Whether you want to specify dataset-level custom naming formats for the Snapshot copy,

volume, and qtree objects that are generated by local policy or storage service protection jobs on
the virtual objects in this dataset.
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About this task

The Create Dataset dialog box allows you to create an empty dataset, a populated but unprotected
dataset, a populated, remotely protected dataset, a populated locally protected dataset, or a populated
partially-configured or fully-configured dataset. A minimally configured dataset is an empty dataset.
Virtual objects are unprotected if they do not belong to a dataset that has been assigned a local
policy.

Steps

1. Click the NetApp tab, and then click Datasets under Backup and Recovery in the navigation
pane.

2. In the Datasets panel, click Create.

3. In the Create Dataset dialog box, select the Name option and enter the requested information in
the sub-tabs of the associated content area.

a. Enter the dataset name and administrative contact information in the General Properties tab.

b. If you want to specify dataset-level naming formats to apply to the Snapshot copy, volume,
and qtree objects that are generated by local policy or storage service protection jobs that are
run on this dataset, select the appropriate options in the Naming Properties tab.

4. If you want to specify, at this time, the virtual objects to include in this dataset, select the Data
option and make your selections in the associated content area.

You can also add or change this information for this dataset at a later time.

5. If you want to specify, at this time, a storage service that will execute remote protection for the
objects in this dataset, select the Storage Service option and make your selection.

You can also add or change this information for this dataset at a later time.

6. If you want to specify or create and configure, at this time, a local policy that will execute local
protection for the objects in this dataset, select the Local Policy option and make your local
policy selection or configuration.

You can also add or change this information for this dataset at a later time.

7. After you specify your desired amount of information about this dataset, click OK.

Related references

Administrator roles and capabilities on page 55
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Restoring from a legacy backup

This workflow shows you how to restore a backup taken using the Virtual Storage Console . This
enables you to restore data that you backed up using a previous version of the Virtual Storage
Console software.

Before you begin

You must have installed and configured the OnCommand console and OnCommand Plug-in for
VMware.

You must have already backed up a virtual machine or its disk files using legacy Backup and
Recovery before you can recover it.

You must be familiar with VMware concepts and Virtual Storage Console . For more information on
restore operations, see the OnCommand Help.

About this task

This workflow is based on the assumption that you use Virtual Storage Console 2.0.1 or later.

Restoring a virtual machine or its disk files
You can use the Backup and Recovery capability to restore an entire virtual machine or particular
virtual disks of a given virtual machine. By doing so, you overwrite the existing content with the
backup you select.

Before you begin

You must have already backed up a virtual machine or its disk files using OnCommand Plug-in for
VMware or Legacy Backup and Recovery before you can recover it.

Steps

1. Select a virtual machine in the Inventory panel, and then right-click the node and select the
NetApp > Backup and Recovery > Restore from the context menu.

The Restore wizard opens and lists all backups which include the virtual machine.

2. From the Backups table, select a backup of the virtual machine and click Next to display the
Virtual Machine Component Selection page.

3. Select one of the following recovery options:
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Option Description

The entire virtual
machine

Restores the contents of your virtual machine from a Snapshot copy. The Start
VM after restore checkbox is enabled if you select this option and the virtual
machine is registered.

Particular virtual
disks

Restores the contents of the virtual disks on a virtual machine. This option is
enabled if you uncheck the entire virtual machine option.

4. In the ESX Host Name field, select the name of the ESX host.

This option is available if you want to restore virtual disk files or the virtual machine is on a
VMFS datastore.

5. Click Next to display the Summary page, which displays information about the restore that is
about to be performed.

6. From this page, view the settings and click Restore to begin the restoration.

After you finish

After you end the Restore wizard and start the restore job, you can track the progress of the restore
job from the Task tab of the Status panel, and monitor the job for possible errors.

Related references

Administrator roles and capabilities on page 55
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Restoring a single file from a backup

This workflow shows you how to restore a single file from a backup made in a VMware
environment. You might want to do this if a file, virtual machine, or database has been corrupted.
You can locate the backup, mount, and unmount the backup using OnCommand console, but you
must use the vSphere Client to restore the file.

Before you begin

You must have installed and logged into the following software:

• OnCommand console
• vSphere Client

You must be familiar with the protection concepts of a dataset, protection policy, and backup
schedule. For more information on these concepts, see the OnCommand console Help.

About this task

VMware ESX 4.x currently does not support hot-removal of LUNs. Hot-removal of LUNs can also
affect restore unmounting processes within backup and recovery, as well as destroy datastores within
provisioning and cloning. For more information, see VMware KB article 1015084 or bug report
346071.

Steps

1. Locate a backup on page 26
You must first locate the backup in OnCommand console that contains the file that you want to
restore. This enables you to use the backup version containing the information you want to
restore.

2. Mount a backup on page 26
You can mount a backup using OnCommand console. After the backup is mounted on an ESX
server, you can locate the file that you want to restore. Using the VMware application, you can
restore the file you have selected.

3. Restore a single file using VMware on page 28
After you have mounted a backup using OnCommand console, you can use the VMware
application to restore the single file. After the restore is complete, you must unmount the backup.

4. Unmount a backup on page 28
After you have located the file and restored it, you can use OnCommand console to unmount the
backup. Unmounted backups are not deleted.

Related information

http://kb.vmware.com/kb/1015084
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Bugs Online - now.netapp.com/NOW/cgi-bin/bol

Locating specific backups
You can locate a specific backup copy by searching for different criteria such as names and
descriptions. After you locate a backup, you can then restore it, view the status of it, or delete it.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

About this task

You can locate a specific backup copy by searching one of the following criteria:

• Whole or partial backup description
• Partial current name of a primary object in the backup
• Partial name of a virtual object when the backup was taken
• UUID of a virtual object within the backup

Steps

1. Click the View menu, then click the Backups option.

2. From the Backups tab, locate the Search field, and type in all or part of the backup description or
version.

You can locate multiple backup versions by inserting a comma between search terms and you can
clear the search field to view all backups.

3. Click Find.

Related references

Administrator roles and capabilities on page 55

Mounting backups in a VMware environment from the
Backups tab

You can mount existing backups onto an ESX server for backup verification prior to completing a
restore operation or to restore a virtual machine to an alternate location. All the datastores and the
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virtual machines within the backup are mounted to the ESX server that you specify. Both the Mount
and Unmount buttons are disabled for Hyper-V backups.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

About this task

In the OnCommand console Backups tab, deleting a mirror source backup copy prevents you from
mounting its partner mirror destination backup copy. For a Mirror-generated destination backup copy
to be mountable, its associated mirror source backup copy must still exist on the source node.

Steps

1. Click the View menu, then click the Backups option.

2. In the Backups tab, select an unmounted backup that you want to mount.

3. Click Mount.

You cannot mount Hyper-V backups using this button.

4. In the Mount Backup dialog box, select from the drop-down list the name of the ESX server to
which you want to mount the backup.

You can only mount one backup each time and you cannot mount a mounted backup.

5. Click Mount.

A dialog box appears with a link to the mount job and when you click the link, the Jobs tab
appears.

After you finish

You can monitor the status of your mount and unmount jobs in the Jobs tab.

Related concepts

Guidelines for mounting or unmounting backups in a VMware environment on page 69

Related references

Administrator roles and capabilities on page 55
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Using VMware to restore a single file
After you have mounted a backup, you can use VMware to restore a single file.

About this task

For more detailed information on the steps performed in this task, see Knowledge Base article
1011968.

Steps

1. Find the VMDK you need from within the mounted backup datastore.

2. Attach that VMDK to the virtual machine to which you need to restore the file.

3. If the partitions on the newly mounted VMDK do not appear as drive letters in Windows, bring
the disks online in the Windows Disk Management Utility.

4. Restore the file by dragging it to the appropriate location, using Windows Explorer or other file
browser.

5. Detach the backup VMDK from the virtual machine.

After you finish

You must now unmount the backup in the OnCommand console.

Related information

Knowledge Base article 1011968

Unmounting backups in a VMware environment from the
Backups tab

After you are done using a mounted backup for verification or to restore a virtual machine to an
alternate location, you can unmount the mounted backup from the ESX server that it was mounted to.
When you unmount a backup, all the datastores in that backup are unmounted and can no longer be
seen from the ESX server that you specify. Both the Mount and Unmount buttons are disabled for
Hyper-V backups.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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About this task

If there are virtual objects in use from the previously mounted datastores of a backup, the unmount
operation fails. You must manually clean up the backup prior to mounting the backup again because
its state reverts to not mounted.

If all the datastores of the backup are in use, the unmount operation fails but this backup's state
changes to mounted. You can unmount the backup after determining the datastores are not in use.

Steps

1. Click the View menu, then click the Backups option.

2. In the Backups tab, select a mounted backup to unmount.

3. Click Unmount.

4. At the confirmation prompt, click Yes.

A dialog box opens with a link to the unmount job displays and when you click the link, the Jobs
tab appears.

After you finish

If the ESX server becomes inactive or restarts during an unmount operation, the job is terminated and
the mount state remains mounted and the backup stays mounted on the ESX server.

You can monitor the status of your mount and unmount jobs in the Jobs tab.

Related concepts

Guidelines for mounting or unmounting backups in a VMware environment on page 69

Related references

Administrator roles and capabilities on page 55

Restoring a single file from a backup | 29



30 | OnCommand™ Guide to Common Workflows



Supporting delegated management for virtual
infrastructure administration

This workflow shows you how to delegate protection of virtual objects to a virtual infrastructure
administrator. You delegate control to the virtual infrastructure administrator when there are two or
more administrators in your environment and you must separate system responsibilities.

Before you begin

You must have installed the OnCommand console and Operations Manager console.

You must have already created the storage services that you want to allow the virtual infrastructure
administrator to use.

You must be familiar with the concepts of a virtual dataset and role based access control
management (RBAC). For more information on dataset concepts, see the OnCommand console Help.
For more information about RBAC concepts, see the Operations Manager console Help.

About this task

Typically, the storage administrator administers the system and has full control. The virtual
administrator administers only the virtual portion of the environment, including creating, backing up,
and restoring virtual machines. You can give a virtual infrastructure administrator focused,
appropriate control without full access to the entire system.

Steps

1. Launch the Operations Manager console on page 32
Creating an account for the virtual infrastructure administrator is performed in the Operations
Manager console. You can launch the Operations Manager console from the OnCommand
console.

2. Create an administrative role on page 32
This administrative role contains the virtual objects and permissions that you will later assign to a
user account for the virtual administrator. Before adding the virtual objects and permissions to the
role, you must create an empty group, protection policies, and storage services for the virtual
administrator.

3. Create an administrative user on page 33
Creating a user account for a virtual infrastructure administrator allows you to assign a role
containing virtual objects and permissions to the virtual administrator.

4. Create a group on page 33
This empty group contains the operations and permissions specific to the virtual administrator,
along with datasets and local policies that the virtual administrator will create later.

5. Assign permissions to an administrative role on page 34
After you have created an administrative role, group, application and protection policies, and
storage services for the virtual administrator, you can assign the operations and permissions for
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the administrative user. For information on which access permissions to assign to an
administrative role for a virtual administrator, see Access permissions for Virtual Infrastrature
Administrator role.

6. Edit the group membership to include the vCenter member on page 35
You must edit the group membership for a virtual infrastructure administrator to include the
vCenter member.

Related concepts

What a dataset is on page 72

Launching the Operations Manager console
You can launch the Operations Manager console from the OnCommand console to perform many of
your physical storage tasks.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

About this task

During this task, the OnCommand console launches the Operations Manager console. Depending on
your browser configuration, you can return to the OnCommand console by using the Alt-Tab key
combination or clicking the OnCommand console browser tab. After the completion of this task, you
can leave the Operations Manager console open, or you can close it to conserve bandwidth.

Step

1. Click the File menu, then click Operations Manager.

The Operations Manager console opens in a separate browser tab or window.

Creating an administrative role
You can create a role for an administrator from the Setup menu in Operations Manager.

Steps

1. Select Roles from the Setup menu.

2. Enter the name of the role and the description of the role that you want to add.

3. Select any of the pre-created roles that you want to assign to this role; otherwise, select None.
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4. Click Add Role.

Adding administrative users
You can create administrator accounts from the Operations Manager console. Administrator accounts
are either an individual administrator or a group of administrators.

Before you begin

The DataFabric Manager server user must be a local operating system user, or a domain user
reachable by LDAP.

Steps

1. Log in to the Administrator account.

2. In the Operations Manager console, click Setup > Administrative users.

3. Type the name for the administrative user or domain name for the group of administrators.

When you add the user, they must be present locally.

4. If you have already created a role that you want to assign to this user or group of users, select the
role in the left column of the displayed table and use the arrow button to move the role to the
column on the right.

Roles in the column on the right are assigned to the user you are creating.

5. Type the e-mail address for the administrator or administrator group.

6. Enter the pager number for the administrator or administrator group.

7. Click Add.

After you finish

If you have not created a role for the user you created in this task, you must next create a role.

Creating groups
You can create a new group from the Edit Groups page. You can group objects based on storage
systems at a location, or all file systems that belong to a specific project or group in your
organization.

Before you begin

To create a group, you must be logged in as an administrator with a role having Database Write
capability on the parent group. To create a group directly under the Global group, the administrator
must have a role with Database Write capability on the Global group.
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Steps

1. From the Control Center, click the Edit Groups.

2. In the Group Name field, type the name of the group you want to create.

See “Naming conventions” for groups.

3. From the list of groups, select the parent group for the group you are creating.

You might need to expand the list to display the parent group you want.

4. Click Add.

Result

The new group is created. The Current Groups list in the left-pane area is updated with the new
group. You might need to expand the Current Groups list to display the new group.

Assigning permissions to an administrative role
You can assign to a role permissions specific to a user's task.

Before you begin

You must have created the group, storage services, and application policies, if appropriate, for a
virtual infrastructure administrative role.

Steps

1. From the Setup menu, select Roles.

2. Select the role to which you want to add capabilities

3. Click Add Capabilities.

4. Select each resource for which you want to assign administrative permissions, then check the
appropriate permissions for each corresponding operation.

See Access permissions for the Virtual Infrastructure Administrator on page 35 for a list of
permissions you need to assign to the virtual administrative role.

5. Click OK.

6. Optionally, to copy capabilities from an existing role, select that role from the Inherit
Capabilities list and click \>> to move the role to the list at the right.

7. Click Update.
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Access permissions for the Virtual Infrastructure Administrator role
When you create a virtual infrastructure administrator, you must assign specific permissions to
ensure that the administrator can view, back up, and recover the appropriate virtual objects.

A virtual infrastructure administrator role must have the following permissions for the resources:

Groups The VI administrator will need the following operation permissions for the group
created for the VI administrator role.

DFM.Database All

DFM.BackManager All

DFM.ApplicationPolicy All

DFM.Dataset All

DFM.Resource Control

Policies The VI administrator will need the following operation permissions for each policy
template, located under Local Policies, that you want the virtual administrator to be
able to copy.

DFM.ApplicationPolicy Read

Storage
services

The VI administrator will need the following operation permissions for each of the
storage services that you want to allow the VI administrator to use.

DFM.StorageService Attach, read, detach, and clear

Protection
Policies

These are the policies contained within the storage services that you selected above.

DFM.Policy All

Editing group membership
You can add members or delete members from the Edit Group dialog box.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

If you have created a new group for a virtual infrastructure administrator, you must have added
vCenter to the group membership using the OnCommand console GUI.
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Steps

1. Click the Administration menu, then click the Groups option.

2. From the Groups tab, select the group you want to modify.

3. Click Edit.

4. In the Edit Group dialog box, click the Group Member tab.

5. Select the type of member you want to add or delete from the Member Type field.

6. Perform one of the following steps to add or delete a group member.

To do this ... Take this action ...

Add a member to the group ... Move a member type to the Selected Members list.

Remove a member from the group ... Move a member type to the Available Members list.

7. Click OK.
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Resolving issues with virtual objects

This workflow shows you how to resolve an issue for a virtual object by monitoring and
troubleshooting the virtual object, and correcting errors in the virtual object policy. You need to
troubleshoot and resolve issues for your virtual objects if you discover problems while monitoring
the Dataset Status dashboard panel.

Before you begin

You must have installed the OnCommand console.

About this task

This workflow is based on the assumption that a virtual object is being affected by two jobs that have
been scheduled so that they overlap. This workflow assumes that you are familiar with the concepts
of a virtual dataset and a protection policy. For more information on these concepts, see the
OnCommand console Help.

Steps

1. Monitor dashboard panels on page 37
You can view the dashboard panel to monitor virtual datasets and identify datasets that are
experiencing problems.

2. Monitoring dataset status on page 38
You can monitor the status of your datasets for possible errors.

3. Edit a dataset containing virtual objects to reschedule or modify local backup jobs on page 39
You can correct a problem with a dataset policy by editing the local settings of the dataset.

Related concepts

What a dataset is on page 72

Role of protection policies in dataset management on page 70

Monitoring dashboard panels
You can use the dashboard panels to monitor your physical storage, logical storage, virtual storage
and non-storage objects.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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Steps

1. Log in to the OnCommand console. By default, the Dashboard tab is displayed.

2. To view details about any of the information displayed in the dashboard panels, click the panel
heading to display the relevant OnCommand console tab.

You can also click any hypertext links in the individual dashboard panels to view detailed
information.

Related references

Administrator roles and capabilities on page 55

Monitoring dataset status
You can monitor the status of your datasets for possible errors.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

Steps

1. Click the View menu and click the Datasets option.

2. In the Datasets tab, select the dataset whose status you want to monitor.

The Overview area of the Datasets tab displays the protection, conformance, resources, and space
statuses of the selected dataset.

3.
To view status details, click the  button, if displayed.

If the  button is displayed for resources, clicking it displays a dialog box that lists events
related to warning-level or critical-level resource issues. You can use the Acknowledge button to
mark an event as acknowledged. If you take actions outside of the dialog box that resolves an
event issue, you can use the Resolve button to mark that event as resolved.

4. To view details about secondary or tertiary nodes, click the corresponding tabs for these nodes.

Related references

Administrator roles and capabilities on page 55
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Editing a dataset containing virtual objects to reschedule or
modify local backup jobs

You can modify the schedule of local backup jobs that are configured in the local policy assigned to
a dataset containing virtual VMware objects or virtual Hyper-V objects.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

About this task

If you need to reschedule or modify the local backup jobs associated with the local policy of a dataset
of virtual objects, you can edit the Local Policy settings of that dataset.

Steps

1. Click the View menu and click the Datasets option.

2. In the Datasets tab, select the dataset on which you want to schedule and configure local backups
and click Edit.

3. In the Edit Dataset dialog box, locate the Local settings option and click >.

4. Modify the local backup jobs as needed.

5. After you finish changing the schedule for the local policy to this dataset, click OK.

Result

Any local policy modification that you completed will be applied to the local protection of the virtual
objects in all datasets that use that local policy.

Related references

Administrator roles and capabilities on page 55
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Resolving issues with physical objects

This workflow show you how to resolve an issue for a physical object. You can monitor your
physical objects using the dashboard and manually launch NetApp Management Console to resolve
the issue.

Before you begin

You must have installed OnCommand console and NetApp Management Console.

You must be familiar with the protection concepts of a dataset and secondary space management. For
more information on these concepts, see the OnCommand console Help.

About this task

This workflow is based on the assumption that you are resolving an issue with a volume that is going
to run out of space soon. This is important to solve because applications that are run on this volume
could run out of space and stop operating.

This workflow begins in the OnCommand console, but you must also manually launch NetApp
Management Console to resolve the problem.

This workflow assists with one type of issue resolution. Depending on what your issue is, there are
additional ways to resolve it.

During the performance of this workflow, you must manually launch NetApp Management Console,
using the same server as OnCommand. NetApp Management Console does not open automatically.

Steps

1. Monitor dashboard panels on page 37
You can use the Full Soon Storage dashboard panel to find volumes that are running out of space.
After identifying the volume, you must manually start NetApp Management Console.

2. Start Secondary Space Management wizard on page 42
Using the Secondary Space Management wizard enables you to resize a volume that is running
out of space. In addition to resizing, you can also delete backups, perform deduplication, or
migrate volumes to another aggregate. Before using this wizard, you should understand how the
Secondary Space Management wizard works.
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Monitoring dashboard panels
You can use the dashboard panels to monitor your physical storage, logical storage, virtual storage
and non-storage objects.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

Steps

1. Log in to the OnCommand console. By default, the Dashboard tab is displayed.

2. To view details about any of the information displayed in the dashboard panels, click the panel
heading to display the relevant OnCommand console tab.

You can also click any hypertext links in the individual dashboard panels to view detailed
information.

Related references

Administrator roles and capabilities on page 55

Starting secondary space management
You can identify volumes that have space issues, plan actions to resolve those issues, and implement
the selected actions by using the Secondary Space Management wizard.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

Steps

1. From the NetApp Management Console navigation pane, click Hosts > Aggregates.

2. Select an aggregate and click Manage space to start the Secondary Space Management wizard.

3. Complete the steps in the wizard to plan and implement tasks to reclaim space on the selected
aggregate.

Related concepts

How the Secondary Space Management wizard works on page 69
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Related references

Administrator roles and capabilities on page 55
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Changing the storage service for a virtual dataset

This workflow shows you how to change the storage service for a virtual dataset by using the Change
Storage Service wizard.

Before you begin

You must have installed the OnCommand console and NetApp Management Console.

About this task

This workflow is started from the OnCommand console, but it is performed in the NetApp
Management Console and assumes that you are familiar with the concepts of a virtual dataset and a
protection policy. For more information on these concepts, see the OnCommand console Help.

Changing a storage service for a virtual dataset is different from changing it for a physical storage
dataset. This task can be started from the OnCommand console, but the system launches NetApp
Management Console to perform the task.

Note: If you are in OnCommand Plug-in for VMware, you must navigate to the OnCommand
console to launch NetApp Management Console.

You need to change the storage service for your virtual dataset if you change your requirements for
your dataset protection. For example, you need to change your storage service if you want to add
mirroring to SnapVault backups or upgrade your service from bronze to gold. If you change the
underlying topology of your system, you also need to change the provisioning, and so forth. For
example, if you change from backup to mirror and then back to backup, you must reprovision and
possibly rebaseline. Reprovisioning, rebaselining, and so forth can impact performance, and you
should consider this impact prior changing your storage service.

Changing a storage service on datasets of storage objects
You can use the Change Storage Service wizard to change a storage service on datasets of storage
objects that already have another storage service attached.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

The following conditions must exist:

• The new storage service that you want to attach is available in the group in which you want to
locate that dataset.
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• All datasets to which you want to attach the new storage service are currently attached to the
same current storage service.

About this task

The Change Storage Service wizard allows you to select an alternative storage service, presents you
with possible node remapping alternatives along with rebaselining requirements for each alternative,
carries out a dry run of your request, and then implements your request upon your approval.

During this task, the OnCommand console launches NetApp Management Console. Depending on
your browser configuration, you can return to the OnCommand console by using the Alt-Tab key
combination or clicking the OnCommand console browser tab. After the completion of this task, you
can leave the NetApp Management Console open, or you can close it to conserve bandwidth.

Steps

1. Click the View menu and click the Datasets option.

2. In the Datasets tab, select the dataset whose storage service you want to change, click More then
select Storage Service and Change to start the Change Storage Service wizard.

3. After you complete each property sheet in the wizard, click Next.

4. Confirm the details of the storage service and click Finish.

5. Press Alt-Tab or click the OnCommand console browser tab to return to the OnCommand
console.

6. Refresh your browser to update the OnCommand console with the changes you made.

Result

The selected datasets are listed in the datasets table with their newly attached storage service named
in the storage service column.

Related references

Administrator roles and capabilities on page 55
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Resolving dataset conformance issues

This workflow shows you how to resolve a dataset that is in a nonconformant state. Resolving a
dataset's conformance issues helps ensure that its protection jobs are fully successful.

Before you begin

You must have installed the OnCommand console.

You must be familiar with the concepts of a dataset containing virtual objects, a storage service, a
protection policy, and conformance. For more information about these concepts, see the
OnCommand console Help.

About this task

When the OnCommand console conformance checker encounters a dataset condition that is
nonconformant with the provisioning and protection policies of the dataset's assigned storage service,
it first attempts to correct that condition automatically. However, if the condition requires user
consent to correct, or if the condition must be corrected manually, then the conformance checker
assigns nonconformant status to the dataset. If the dataset is tagged with nonconformant status,
operations associated with the assigned storage service's protection and provisioning policies cannot
be fully executed until the nonconformant condition is resolved.

If the conformance checker encounters the nonconformant condition during initial storage service
assignment or in an existing dataset later on, it flags that condition for the administrator in the
Datasets tab. The administrator can select the nonconformant dataset and display the Conformance
Details dialog box to view that dataset's conformance issues.

The conformance checker actively monitors a dataset's resources during dataset storage service
assignment and at intervals thereafter to make sure that the resource configuration remains in
conformance with (is able to support) the protection policies and provisioning policies that are
included in the storage service assigned to it.

Steps

1. List the nonconformant dataset and view the details on page 48
OnCommand console routinely scans your datasets to ensure that they are in conformance with
their assigned policies. You can list a dataset that has fallen out of conformance with its protection
and provisioning policies, then view the nonconformance details.

2. Evaluate the conformance error messages on page 49
Use the Conformance Details dialog box to evaluate a dataset's conformance issues. You can
evaluate the error and warning text that the dialog displays and attempt to resolve the
conformance issues they describe.

3. Resolve the conformance issues automatically without a baseline transfer on page 50
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If the text displayed in the Conformance Details dialog box identifies conformance issues that you
can automatically resolve without a rebaseline of data, you can use the dialog box controls to do
so.

4. Resolve the conformance issues manually without a baseline transfer of data on page 51
If the text displayed in the Conformance Details dialog box identifies conformance issues that you
cannot or choose not to resolve automatically, you can resolve the conformance issues manually.

5. Resolve conformance issues manually when a baseline transfer of data might be necessary
on page 53

If the text displayed in the Conformance Details dialog box identifies conformance issues whose
automated resolution might require a baseline transfer, attempt a manual resolution before using
automated resolution.

Related concepts

What a dataset is on page 72

Role of protection policies in dataset management on page 70

Dataset concepts on page 57

Datasets of virtual objects on page 59

Why datasets fail to conform to policy on page 72

Related references

Descriptions of dataset conformance status on page 66

Listing nonconformant datasets and viewing details
You can list existing datasets that have become nonconformant with their protection and provisioning
policies. Then, you can view and attempt to resolve their nonconformance. Conformance issues can
prevent completion of dataset protection and provisioning operations.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

Steps

1. Click the View menu and click the Datasets option to display the Datasets tab.

2. In the Datasets tab click the column header labeled Conformance Status and select
Nonconformant.

3. If the Datasets tab lists a dataset with nonconformant status, select that dataset to display its
Details area.
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4.
In the selected dataset's Details area, click the  button.

The Conformance Details dialog box displays the results of the most recent conformance check
and suggestions for resolving the issues encountered.

After you finish

After you display the Conformance Details dialog box, you must address and resolve the issues that
are indicated by its warning and error messages.

Related references

Administrator roles and capabilities on page 55

Evaluating conformance error text
You can use the Conformance Details dialog box to evaluate a dataset's conformance issues. You can
evaluate the error and warning text that the dialog box displays and attempt to resolve the
conformance issues they describe.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

About this task

• This procedure assumes you are viewing the Conformance Details dialog box that you displayed

by selecting a nonconformant dataset in the Datasets tab and clicking  after its Conformance
status display.

• Because of the probable time and bandwidth required for a baseline transfer completion, a
resolution that avoids a baseline transfer of data is preferable to a resolution that triggers one.

• The dialog box displays text with Information, Error, Action, Reason, and Suggestion labels
concerning the nonconformance condition.

Steps

1. Evaluate any labeled text that the dialog box displays.

Information Information text indicates configuration operations that the OnCommand console
successfully completed without conformance issues.

Error Error text indicates the configuration operations that the OnCommand console is
unable to perform on this dataset due to conformance issues.
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Action Action text indicates what the OnCommand conformance engine did to discover
the conformance issue.

Reason Reason text indicates the probable cause of the conformance issue.

Suggestion Suggestion text indicates a possible way of resolving the conformance issue. If
the text is highlighted in yellow, a baseline transfer of data is involved.

2. Based on the dialog box text, decide the best way to resolve the conformance issue.

• If the dialog box text indicates that the OnCommand conformance monitor cannot
automatically resolve the conformance issue, resolve this issue manually.
For details, see "Resolving conformance issues manually without a baseline transfer of data."

• If yellow Suggestion text indicates that automatically resolving the conformance issues
requires a baseline transfer of data, first attempt to resolve this issue manually. If
unsuccessful, consider resolving the issue automatically even if doing so requires a baseline
transfer of data.
For details, see, "Resolving conformance issues manually when a baseline transfer of data
might be necessary."

• If the Suggestion text indicates that the OnCommand conformance monitor can resolve the
conformance issue automatically without reinitiating a baseline transfer of data, first, consider
resolving the issue manually. If unsuccessful, resolve the issue automatically.
For details, first see, "Resolving conformance issues manually without a baseline transfer of
data."
Then, if necessary, see "Resolving conformance issues automatically without a baseline
transfer of data."

After you finish

Proceed to the appropriate task to resolve the dataset conformance issues.

Related references

Administrator roles and capabilities on page 55

Resolving conformance issues automatically without a
baseline transfer of data

If the text displayed in the Conformance Details dialog box identifies conformance issues that you
can automatically resolve without reinitializing a baseline transfer of data, you can use the dialog box
controls to do so.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

50 | OnCommand™ Guide to Common Workflows



About this task

• Because of the probable time and bandwidth required for a baseline transfer completion, a
resolution that avoids a baseline transfer of data is preferable to a resolution that triggers one.

• This procedure assumes you are viewing the Conformance Details dialog box that you displayed

by selecting a nonconformant dataset Datasets tab and clicking  after its nonconformant status
display.

Steps

1. In the Conformance Details dialog box, read the text to determine the ability of the conformance
engine to automatically resolve the nonconformant condition without reinitializing a baseline
transfer of data.

2. If the text suggests that a simple automatic resolution is possible, click Conform .

The OnCommand console conformance engine closes the Conformance Details dialog box and
attempts to reconfigure storage resources to resolve storage service protection and provisioning
policy conformance issues automatically.

3. Monitor the conformance status on the Datasets tab for one of the following values:

• Conformant: The conformance issue is resolved.
• Nonconformant: The conformance issue is not resolved. Consider manual resolution of the

issue.

After you finish

After you achieve dataset conformant status, continue with the operation that required the dataset to
be conformant.

Related references

Administrator roles and capabilities on page 55

Resolving conformance issues manually without a baseline
transfer of data

If the text displayed in the Conformance Details dialog box identifies conformance issues that you
cannot resolve automatically, you can resolve the conformance issue manually.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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About this task

• Because of the probable time and bandwidth required for a baseline transfer completion, a
resolution that avoids a baseline transfer of data is preferable to a resolution that triggers one.

• This procedure assumes you are viewing the Conformance Details dialog box that you displayed

by selecting a nonconformant dataset Datasets tab and clicking  after its nonconformant status
display.

Steps

1. In the Conformance Details dialog box, confirm that the messages indicate that the conformance
issues cannot be resolved automatically.

2. Using the conformance messages, determine what is causing the nonconformance problem and
attempt to correct the condition manually.

You might need to log in to another GUI or CLI console to resolve the issues.

3. After you have attempted to correct the condition, wait at least one hour for the conformance
monitor to update the dataset's conformance status.

4. Return to the Conformance Details dialog box and click Test Conformance to determine if the
conformance issue is resolved.

If the conformance issue is resolved, the Conformance Details dialog box does not display the
"Conform" button.

5. If the conformance issue is resolved, click Cancel.

6. If the conformance issue is not resolved, repeat Steps 2, 3, and 4.

After you finish

After you achieve dataset conformant status, continue with the operation that required the dataset to
be conformant.

Related references

Administrator roles and capabilities on page 55
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Resolving conformance issues manually when a baseline
transfer of data might be necessary

If the text displayed in the Conformance Details dialog box identifies conformance issues whose
automated resolution might require a baseline transfer of data, attempt a manual resolution before
using automated resolution.

Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

About this task

• Because of the probable time and bandwidth required for baseline transfer completion, a
resolution that avoids a baseline transfer of data is preferable to a resolution that triggers one.

• This procedure assumes you are viewing the Conformance Details dialog box that you displayed

by selecting a nonconformant dataset in the Datasets tab and clicking  after its nonconformant
status display.

Steps

1. In the Conformance Details dialog box, confirm that warning text is displayed that indicates that
a reinitialized baseline transfer of data might be required.

You should try to resolve the conformance issues manually before initializing a time-consuming
baseline transfer of your data.

2. Using the conformance messages, determine what is causing the conformance problem and
attempt to correct the condition manually.

You might need to log in to another GUI or CLI console to resolve the issues.

3. After you have attempted to correct the condition, wait at least one hour for the conformance
monitor to update the dataset's conformance status.

4. Return to the Conformance Details dialog box and click Test Conformance to determine if the
conformance issue is resolved.

If the conformance issue is resolved, the Conformance Details dialog box does not display the
"Conform" button.

5. If the conformance issue is not resolved, click Conform to attempt automated resolution and
initiate a rebaseline of your data.
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After you finish

After you achieve dataset conformant status, continue with the operation that required the dataset to
be conformant.

Related references

Administrator roles and capabilities on page 55
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Appendix of additional information

You can use the additional information provided to assist you in completing the workflows in this
guide.

Administrator roles and capabilities
The RBAC administrator roles determine the tasks you can perform in the OnCommand console.

One or more capabilities must be specified for every role, and you can assign multiple capabilities if
you want the administrator to have more control than a specific role provides. For example, if you
want an administrator to perform both the backup and restore operations, you can create and assign to
the administrator a single role that has both of these capabilities.

You can use the Operations Manager console to create new roles and to customize the default global
roles provided by the DataFabric Manager server and the client applications. For more information
about configuring RBAC, see the OnCommand Operations Manager Administration Guide .

Note: If you want a role with global host service management capability, create a role with the
following properties:

• The role inherits from the GlobalHostService role.
• The role includes the DFM.Database.Read operation on a global level.

Note: A user who is part of the local administrators group is treated as a super-user and
automatically granted full control.

Default global roles

GlobalApplicationProtection Enables you to create and manage application policies, create
datasets with application policies for local backups, use storage
services for remote backups, perform scheduled and on-demand
backups, perform restore operations, and generate reports.

GlobalBackup Enables you to initiate a backup to any secondary volume and
ignore discovered hosts.

GlobalDataProtection Enables you to initiate a backup to any secondary volume; view
backup configurations, events and alerts, and replication or failover
policies; and import relationships into datasets.

GlobalDataset Enables you to create, modify, and delete datasets.

GlobalDelete Enables you to delete information in the DataFabric Manager
server database, including groups and members of a group,
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monitored objects, custom views, primary and secondary storage
systems, and backup relationships, schedules, and retention
policies.

GlobalHostService Enables you to authorize, configure, and unregister a host service.

GlobalEvent Enables you to view, acknowledge, and delete events and alerts.

GlobalFullControl Enables you to view and perform any operation on any object in the
DataFabric Manager server database and configure administrator
accounts. You cannot apply this role to accounts with group access
control.

GlobalMirror Enables you to create, destroy, and update replication or failover
policies.

GlobalRead Enables you to view the DataFabric Manager server database,
backup and provisioning configurations, events and alerts,
performance data, and policies.

GlobalRestore Enables you to restore the primary data to a point in time or to a
new location.

GlobalWrite Enables you to view or write both primary and secondary data to
the DataFabric Manager server database.

GlobalResourceControl Enables you to add members to dataset nodes that are configured
with provisioning policies.

GlobalProvisioning Enables you to provision primary dataset nodes and can attach
resource pools to secondary or tertiary dataset nodes. The
GlobalProvisioning role also includes all the capabilities of the
GlobalResourceControl, GlobalRead, and GlobalDataset roles for
dataset nodes that are configured with provisioning and protection
policies.

GlobalPerfManagement Enables you to manage views, event thresholds, and alarms apart
from viewing performance information in Performance Advisor.

Best practices when adding or editing a dataset of virtual
objects

When you create or edit a dataset of virtual objects, observing best practices specific to datasets of
virtual objects helps you to avoid some performance and space usage problems after configuration.

General best practices for datasets of virtual objects
The following configuration practices apply to both datasets of Hyper-V objects and datasets of
VMware objects:
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• To avoid conformance and local backup issues caused by primary volumes reaching their
Snapshot copy maximum of 255, best practice is to limit the number of virtual objects included in
a primary volume, and limit the number of datasets to which each primary volume is directly or
indirectly included as a member.
A primary volume that hosts virtual objects that are included in multiple datasets is subject to
retaining an additional Snapshot copy of itself for every local backup on any dataset that any of
its virtual object children are members of.

• To avoid backup schedule inconsistencies, best practice is to include only virtual objects that are
located in the same time zone in one dataset.
The schedules for the local protection jobs and remote protection jobs specified in the local
policies and storage services that are assigned a dataset of virtual objects are carried out
according to the time in effect on the host systems that are associated with the dataset's virtual
objects.

Best practices specific to datasets of Hyper-V objects
The following configuration practices apply specifically to datasets containing Hyper-V objects:

• To ensure faster dataset backup of virtual machines in a Hyper-V cluster, best practice is to run
all the virtual machines on one node of the Hyper-V cluster.
When virtual machines run on different Hyper-V cluster nodes, separate backup operations are
required for each node in the cluster. If all virtual machines run on the same node, only one
backup operation is required, resulting in a faster backup.

Best practices specific to datasets of VMware objects
The following configuration practices apply specifically to datasets containing VMware objects:

• If a virtual machine resides on more than one datastore, you can exclude one or more of those
datastores from the dataset. No local or remote protection is configured for the excluded
datastores.
You might want to exclude datastores that contain swap files that you want to exclude from
backup.

• To avoid an excessive amount of secondary space provisioned for backup, best practice when
creating volumes to host the VMware datastores whose virtual machines will be protected by the
OnCommand console backup is to size those volumes to be not much larger than the datastores
they host.
The reason for this practice is that when provisioning secondary storage space to back up virtual
machines that are members of datastores, the OnCommand console allocates secondary space that
is equal to the total space of the volume or volumes in which those datastores are located. If the
host volumes are much larger than the datastores they hold, an excessive amount of provisioned
secondary space can result.

Dataset concepts
Associating data protection, disaster recovery, a provisioning policy, or storage service with a dataset
enables storage administrators automate tasks, such as assigning consistent policies to primary data,
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propagating policy changes, and provisioning new volumes, qtrees, or LUNS on primary and
secondary dataset nodes.

Configuring a dataset combines the following objects:

Dataset of
physical
storage objects

For protection purposes, a collection of physical resources on a primary node,
such as volumes, flexible volumes, and qtrees, and the physical resources for
copies of backed-up data on secondary and tertiary nodes.

For provisioning purposes, a collection of physical resources, such as volumes,
flexible volumes, qtrees, and LUNs, that are assigned to a dataset node. If the
protection policy establishes a primary and one or more nonprimary nodes, each
node of the dataset is a collection of physical resources that might or might not
be provisioned from the same resource pool.

Dataset of
virtual objects

A collection of supported VMware virtual objects or Hyper-V virtual objects that
reside on storage systems. These virtual objects can also be backed up locally
and backed up or mirrored on secondary and tertiary nodes.

Resource pool A collection of physical resources from which storage is provisioned. Resource
pools can be used to group storage systems and aggregates by attributes, such as
performance, cost, physical location, or availability. Resource pools can be
assigned directly to the primary, secondary, or tertiary nodes of datasets of
physical storage objects. They can be assigned indirectly both to datasets of
virtual objects and to datasets of physical storage objects through a storage
service.

Data protection
policy

Defines how to protect primary data on primary, secondary or tertiary storage, as
well as when to create copies of data and how many copies to keep. Protection
policies can be assigned directly to datasets of physical storage objects. They can
be assigned indirectly to both datasets of virtual objects and to datasets of
physical storage objects through a storage service.

Provisioning
policy

Defines how to provision storage for the primary or secondary dataset nodes, and
provides rules for monitoring and managing storage space and for allocating
storage space from available resource pools. Provisioning policies can be
assigned directly to the primary, secondary, or tertiary nodes of datasets of
physical storage objects. They can be assigned indirectly to both datasets of
virtual objects and datasets of physical storage objects through a storage service.

Storage service A single dataset configuration package that consists of a protection policy,
provisioning policies, resource pools, and an optional vFiler template (for vFiler
unit creation). You can assign a single uniform storage service to datasets with
common configuration requirements as an alternative to separately assigning the
same protection policy, provisioning policies, resource pools, and setting up
similar vFiler unit attachments to each of them.

The only way to configure a dataset of virtual objects with secondary or tertiary
backup and mirror protection and provisioning is by assignment of a storage
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service. You cannot configure secondary storage vFiler attachments for datasets
of virtual objects.

Local policy A policy that schedules local backup jobs and designates retention periods for the
local backup copies for datasets of virtual objects.

Related objects Are Snapshot copies, primary volumes, secondary volumes, or secondary qtrees
that are generated as a result of local policy or storage service protection jobs or
provisioning jobs.

The OnCommand console lists related objects for each dataset on the Datasets
tab.

Naming
settings

Are character strings and naming formats that are applied when naming related
objects that are generated as a result of local policy or storage service protection
jobs or provisioning jobs.

Datasets of virtual objects
The OnCommand console enables you to group VMware virtual objects or Hyper-V virtual objects
that reside as data on your storage systems into datasets for purposes of data protection.

You can set up and enhance automated protection and provisioning for a dataset of virtual objects by
configuring the following types of protection:

• You can assign a local policy to configure local backup job scheduling and local backup copy
retention of your virtual object data.

• You can assign a storage service (a preconfigured combination of a protection policy,
provisioning policies, and resource pools) to configure secondary storage and tertiary storage
backup and mirroring of your virtual object data.

Decisions to make before adding a schedule
Before you use the Add Schedule wizard to add a new protection or throttle schedule to your list of
existing schedules, you must make some decisions about the need for and the type of schedule that
you want to create.

Preliminary schedule decisions

• Can the protection policies that you want to apply use their currently assigned schedules?
If not, do you want to apply different daily, weekly, monthly, or throttle schedules to the primary
node, backup connection, or mirror connection components of those protection policies?

• If a policy requires an different daily, weekly, monthly, or throttle schedule, can you assign an
existing schedule of that type, or do you need to create a new schedule?

• If you need to create a new schedule, what is its name and description?

Appendix of additional information | 59



Daily schedule creation decisions

If you need to add a daily schedule, make the following decisions before starting the Add Schedule
wizard:

• Do you want to use this daily schedule for specifying hourly backup and mirror operations and, if
so, over what hours and at what time intervals?
A common practice is to schedule frequent hourly backup and mirror operations at the Primary
Data node during working hours or periods of heavy data input.

• Do you want to schedule hourly backup operations at intervals shorter than an hour?
Protection configurations on which you plan to schedule backup operations at intervals of less
than an hour require that both the source and destination nodes are preconfigured with the
SnapMirror license.

• Do you want daily backups for retention purposes, and if so, at what times in the day?
When you apply this schedule to a protection policy node, you can assign different retention
durations to your hourly and daily backups. A common practice is to schedule one or two daily
backup operations per day, at least one of which is during nonworking hours.

• Do you want to schedule daily mirror operations at odd times in addition to the regular hourly
mirror operations that you will set up in this schedule?

Weekly schedule creation decisions

If you need to add a weekly schedule, make the following decisions before starting the Add Schedule
wizard:

• Do you want to apply existing daily schedules to this weekly schedule? If so, for which days of
the week (for example, Daily schedule A: Saturday through Sunday, Daily schedule B: Monday
through Friday)?
The hourly and daily backups in the applied daily schedules are automatically included in the new
weekly schedule.

• Do you want weekly backups for retention purposes?
When you apply this schedule to a protection policy node, you can assign different retention
durations to your hourly, daily, and weekly backups.

• Do you want to schedule weekly mirror operations at odd times in addition to the times already
specified for the hourly or daily mirror operations of the applied daily schedules?

• Which days and times during the week do you want to schedule weekly backup or mirror
operations?
A common practice is to schedule one or two weekly backups per week.

Monthly schedule creation decisions

If you need to add a monthly schedule, make the following decisions before starting the Add
Schedule wizard:

• Do you want to apply an existing daily or weekly schedule to this monthly schedule?
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The hourly, daily, and weekly backup and mirror operations in the applied daily or weekly
schedule are automatically included in the new monthly schedule.
If you specify a daily schedule, that schedule applies to every day of the month; if you specify a
weekly schedule, that schedule applies to every week of the month.

• Do you want monthly backups for retention purposes?
When you apply this schedule to a protection policy node, you can assign different retention
durations to your hourly, daily, weekly, and monthly backups.

• Do you want to schedule monthly mirror operations at odd times outside the times already
specified for the hourly, daily, or weekly mirror operations of the applied daily or weekly
schedules?

• Which days and times during the month do you want to schedule monthly backup or mirror
operations?
A common practice is to schedule one or two monthly backups per month.

Throttle schedule creation decisions

Data protection operations can consume large amounts of network bandwidth. If you need to create a
schedule to throttle the bandwidth availability used by these operations, make the following decisions
before starting the Add Schedule wizard:

• Do you want to restrict the network bandwidth available for backup or mirror operations at
certain times of the day?

• Do you want to prevent new backup or mirror operations completely, at certain times of the day?
Zero network bandwidth allotment prevents all new backup or mirror operations during the
period and on the connection in which it is in effect.

Note: When the NetApp Management Console data protection capability executes a mirror
operation that consists of multiple simultaneous data transfers, the NetApp Management Console
divides the total bandwidth allotted to this operation and distributes it equally to each transfer.

Decisions to make before adding datasets of physical
storage objects (for protection)

Before you use the Add Dataset wizard to create a new dataset of physical storage objects and the
Dataset Policy Change wizard to configure protection, you must decide how you want to protect the
data.

Dataset
properties

• Is there a dataset naming convention that you can use to help administrators
easily locate and identify datasets?
Dataset names can include the following characters but cannot be only
numeric:

a to z
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A to Z
0 to 9
. (period)
_ (underscore)
- (hyphen)
space

If you use any other characters when naming the dataset, they do not appear in
the name.

• What is a good description of the dataset membership?
Use a description that helps someone unfamiliar with the dataset to understand
its purpose.

• Who is the owner of the dataset?
• If an event on the dataset triggers an alarm, who should be contacted?

You can specify one or more individual e-mail addresses or a distribution list
of people to be contacted.

• What time zone do you want to use to schedule operations on the dataset be
scheduled according to the local time zone for the data?
You can specify a time zone in the wizard or use the default time zone, which
is the system time zone used by the DataFabric Manager server.

Dataset
naming
properties

• Do you want to use the actual dataset name or a custom label in your dataset-
level Snapshot copy, primary volume, secondary volume, or secondary qtree
naming?

• For customizing the naming settings of object types, do you want the current
default naming format to apply to one or more object types that are generated
in this dataset?
If you want to customize the dataset-level naming formats for one or more
object types, in what order do you want to enter the naming attributes for
Snapshot copy, primary volume, secondary volume, or secondary qtree?

Group
membership

• Do you need to create a collection of datasets and resource pools based on
common characteristics, such as location, project, or owning organization?

• Is there an existing group to which you want to add this dataset?

Resources for
primary
storage

Will you assign a resource pool or individual physical resources as destinations
for your primary storage?

If using a resource pool:

• For the primary node in the dataset, which resource pool meets its provisioning
requirements?

• If no resource pool meets the requirements of the primary node, you can create
a new resource pool for each node at the Resource Pools window.
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• Verify that you have the appropriate software licenses on the storage you
intend to use.

If using individual resources:

• If you prefer not to use resource pools for automatic provisioning, you can
select individual physical resources as members of your dataset.

• Verify that you have the appropriate software licenses on the storage you
intend to use.

Protection
policy

After you create a new dataset of physical objects, you protect it by running the
NetApp Management Console Dataset Policy Change wizard to assign a
protection policy.

• Which protection policy meets the requirements of the dataset?
Review the policies listed on the Protection Policies window to see if any are
suitable for your new dataset.

• If no protection policy meets the requirements of your new dataset, is there a
protection policy that would be suitable with minor modifications?
If so, you can copy that protection policy to create a new policy you can
modify as needed for the new dataset. If not, you can run the Add Protection
Policy wizard to create a new policy for the dataset.

Resources for
secondary or
tertiary
storage

When you assign a protection policy, will you assign a resource pool or individual
physical resources as destinations for your backups and mirror copies?

You do not have to assign a resource pool or physical resources to a node to create
a new dataset. However, the dataset will be nonconformant with its policy until
resources are assigned to each node, because the NetApp Management Console
data protection capability cannot carry out the protection specified by the policy.

If using a resource pool:

• For the secondary or third nodes in the dataset, which resource pool meets
their provisioning requirements?
For example, the resource pool you assign to a mirror node should contain
physical resources that would all be acceptable destinations for mirror copies
created of the dataset members.

• If no resource pool meets the requirements of a node, you can create a new
resource pool for each node at the Resource Pools window.

• Verify that you have the appropriate software licenses on the storage you
intend to use.

If using individual resources:

• If you prefer not to use resource pools for automatic provisioning, you can
select individual physical resources as destinations for backups and mirror
copies of your dataset.
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• Verify that you have the appropriate software licenses on the storage you
intend to use.

Decisions to make before assigning or changing policies
Before you assign or change a policy, you need to gather information about the dataset and policies
that you want the dataset to have.

You need to gather the following information:

Protection
policy

• Which protection policy meets the requirements of the dataset?
Review the policies listed on the Protection Policies window to see if any is
suitable for your new dataset.

• If no protection policy meets the requirements of your new dataset, is there a
protection policy that would be suitable with minor modifications?
If so, you can copy that protection policy to create a new policy you can
modify as needed for the new dataset. If no suitable protection policy exists,
you can run the Add Protection Policy wizard to create a new policy for the
dataset.

Disaster
recovery
policy

• What type of disaster recovery capable protection policy do you need?
The NetApp Management Console data protection capability provides disaster
recovery capable protection policies that function similarly to the backup
policies.

Note: When you change a policy from backup to mirror or mirror to backup,
the Dataset Policy Change wizard prompts you to establish a new baseline
for the relationship. If you do, old data is retained, and the NetApp
Management Console data protection capability makes a new copy of the
entire dataset and transfers the active file system on the secondary. After
reinitialization, you can manually delete the Snapshot copy.

• If you are changing the protection policy to a disaster recovery policy, do you
want to map the settings from a node in the old dataset to a node in the new
dataset?
You should copy the settings only if the path from the primary node is the same
in the new policy as it was in the old policy.

• Do you plan to use a failover script to shut down processes before the NetApp
Management Console data protection capability invokes failover?
If so, you need to define the path to a failover script.

Backup and
mirror node
resources

• If you are changing the protection policy for a dataset with backup and mirror
nodes, do you want to use the same resource assignments that were used in the
previous policy?
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For example, if you have a dataset using the Mirror policy and you want to
change to the Chain of two mirrors policy, you can choose to copy resources
used for the single mirror node in the current policy to one of the two mirror
nodes in the new policy. After you have copied resources from a node in the
current policy, you cannot copy resources from that same node to any other
node in the new policy.

• If you are assigning a policy for the first time or if you do not want to copy
resources used in the current policy, is there a resource pool that meets the
provisioning requirements of the dataset?
For example, the resource pool you assign to a mirror node should contain
physical resources that would all be acceptable destinations for mirror copies
created of the dataset members. If no resource pool meets the requirements of a
nonprimary node, you can create a new resource pool for each backup and
mirror node using the Add Resource Pool wizard.

• If you prefer to not use resource pools for automatic provisioning, which
physical resources would be suitable as destinations for backups and mirror
copies of the dataset?
You do not have to assign a resource pool or physical resources to a destination
node to assign or change a policy. However, the dataset will be nonconformant
with its new policy until resources are assigned to each destination node,
because the NetApp Management Console data protection capability cannot
carry out the protection specified by the policy.

Provisioning
policy

• On which node do you want to assign or change the provisioning policy?
Your dataset might have a primary and one or more nonprimary nodes. You
can assign the same provisioning policy to every node in the dataset, or you can
assign a different provisioning policy to each node.

• Which provisioning policy meets the requirements of the dataset node?
Review the policies listed on the Provisioning Policies window to see if any is
suitable for the dataset node.
If you are changing the provisioning policy, the policy type (NAS or SAN) on
the primary dataset node must match the policy type assigned to the
nonprimary node. If you want to assign a NAS or SAN type provisioning
policy instead of a secondary type policy to a nonprimary node, the dataset
must be disaster recovery capable. This means that it must also have a
protection policy assigned that supports disaster recovery, and the node must be
the disaster recovery capable node.

• If no provisioning policy meets the requirements of the dataset node, is there a
provisioning policy that would be suitable with minor modifications?
If so, you can copy that policy to create a new policy that you can modify as
needed. If not, you can run the Add Provisioning Policy wizard to create a new
policy for the dataset node.

Appendix of additional information | 65



Descriptions of dataset conformance status
The dataset conformance status indicates whether a dataset is configured according to its local policy
or storage service's protection policy. To be in conformance, all secondary and tertiary storage that is
part of the backup relationship must be successfully provisioned and the provisioned objects must
match the requirements of the primary data. You can monitor dataset status using the Datasets tab.

The OnCommand console regularly checks a dataset for conformance. If it detects changes in the
dataset's membership or policy definition, the console does one of three things:

• Automatically performs corrective steps to bring a dataset back into conformance
• Presents you with a list of actions for your approval prior to correction
• Lists conditions that it cannot resolve

You can view these actions and approve them in the Conformance Details dialog box.

A dataset might be nonconformant because there are no available resources from which to provision
the storage or because the NetApp Management Console data protection capability does not have the
necessary credentials to provision the storage resources.

The following list describes dataset conformance values:

Conformant The dataset is conformant with all associated policies.

Conforming The dataset is not in conformance with all associated policies. The OnCommand
console is performing actions to bring the dataset into conformance.

Nonconformant The OnCommand console cannot bring the dataset into conformance with all
associated policies and might require your approval or intervention to complete
this task.

Guidelines for adding a dataset of virtual objects
Before you create a dataset of virtual objects, you must decide the type of virtual objects to include
and the name of the dataset. If you want to fully configure your dataset in the initial session, you
must also decide on the set of virtual objects to include, the local policy that you want to assign, and,
if appropriate, the storage service that you want to assign.

The virtual object types you want to include

The dataset that you create can include either VMware virtual objects or Hyper-V virtual objects. A
dataset configured for VMware virtual objects can include Datacenter, Virtual Machine, and
datastore objects. A dataset configured for Hyper-V virtual objects can include virtual machines.
VMware objects and Hyper-V objects cannot co-exist in one dataset.
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The scope of your initial dataset configuration

If you are ready to do so, the Edit Dataset dialog box and its four content areas enable you to create a
fully populated, fully protected dataset in one session.

However, if you are not ready to create a fully configured dataset in the initial session, the Edit
Dataset dialog box also allows you to create an empty dataset, a dataset of unprotected virtual
objects, a dataset of just locally protected virtual objects, or a dataset of virtual objects that are both
locally protected and remotely protected.

You can later edit a partially configured dataset to fully configure its membership or data protection.

General properties information

When you create a dataset for virtual objects, the minimum information you need to provide is the
general property information. If you complete a dataset configuration specifying only this
information, your result is a named but empty dataset.

Name Your company might have a naming convention for datasets. If so, then the best
practice is for the dataset name to follow those requirements.

Description A useful description is one that helps someone unfamiliar with the dataset to
understand its purpose.

Owner The name of the person or organization that is responsible for maintaining the virtual
objects that are included in this dataset.

Contact You can specify one or more individual e-mail addresses or a distribution list of
people to be contacted when an event on the dataset triggers an alarm.

Group If appropriate, you can specify the group to which you assign this dataset.

Naming properties information
When you create a dataset of virtual objects, you can specify dataset-level character strings and
naming formats to be applied to Snapshot copy, primary volume, secondary volume, or secondary
qtree objects that are generated by local policy or storage service protection jobs on this dataset.

You can also accept the globally configured default naming formats for those objects.

Custom Label You can accept the default naming process of including the dataset name as part
of the entire name of related objects created for this dataset or you can specify a
custom character string to use instead.

Snapshot
Copy

You can accept the global default Snapshot copy naming format to be applied to
all local policy or storage service generated Snapshot copies for this dataset, or
you can specify an alternative custom dataset-level naming format.

Secondary
Volume

You can accept the global default secondary volume naming format to be applied
to all local policy or storage service generated secondary volumes for this dataset,
or you can specify an alternative custom dataset-level naming format.
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Secondary
Qtrees

You can accept the global default secondary qtree naming format to be applied to
all local policy or storage service generated secondary qtrees for this dataset, or
you can specify an alternative custom dataset-level naming format.

Data information

If you want to populate your dataset with virtual objects in the same session that you create it, you
must be ready to specify the following information:

Group The resource group from which you want to select virtual objects to
include in the dataset.

Resource type
(applies to datasets
configured for
VMware objects)

If you are configuring a dataset for VMware virtual objects, what class of
supported VMware object (Datacenter, Virtual Machine, or datastore) you
want to include.

Resources in the
dataset

What virtual objects that meet your group and type selection criteria you
want to include in the dataset.

Any VMware datacenter objects that you include in a dataset cannot be
empty. They must contain virtual machine objects or a datastore that
contains virtual machine objects for successful backup.

Spanned entities
(applies to datasets
configured for
VMware objects)

If one of the VMware virtual machine objects that you want to include in a
dataset spans two or more datastores, the option of whether to include or
exclude any of those datastores from that dataset.

Local policy information

If you want to set up local protection, you must decide whether to apply an existing local policy or to
customize an additional local policy. Local policies specify the backup times, local copy retention
times, no-backup warning and error times, and path to any additional backup script you require.

If you want to set up remote protection, you must still generate local backup copies in primary
storage that an assigned storage service can copy and store in secondary storage. The usual method of
generating backups for this purpose is by scheduling local backup copies in the local policy.

If you intend to implement local backups on multiple datasets of Hyper-V objects that are associated
with the same Hyper-V server, you must configure separate local policies with non-overlapping
schedules to assign separately to each dataset.

Storage services information

If you want to set up remote protection (backup or mirroring to secondary and possibly tertiary
storage locations), you must be ready to select a storage service that is configured with a protection
policy that supports this possibility and to specify the path to any additional backup script that you
require.
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Guidelines for mounting or unmounting backups in a
VMware environment

After you create a full or partial backup of your virtual machine or datastore, you can mount the
backup onto an ESX server to verify what the virtual machine or datastore contains. After you verify
the newly created backup to compare its content to the original and to look for mismatches, you can
unmount the mounted backup.

When you mount or unmount backups, follow these guidelines:

• You cannot mount or unmount Hyper-V backups just like VMware backups by clicking a button.
You can mount Hyper-V backups using a Snapshot copy, virtual hard disk (VHD), LUN and
storage system information available in the OnCommand console GUI.

• You cannot mount a backup on the same or a different ESX server if that backup is already
mounted.
You must unmount this backup from the first ESX server prior to mounting a backup to a
different ESX server.

• You can mount a local backup and a remote backup on any ESX host that is managed by the
same host service that was used when the backup was created.

• If you include the same datastore in multiple backups and those backups are mounted, that
datastore is mounted multiple times.
These datastores can be differentiated because the name includes a mounted timestamp and
contains the dataset name.

• Backup and restore of mounted objects is not supported.
• If there is some data written in the mounted datastore, that data is lost when you unmount the

backup.
• If a backup is mounted, you cannot delete it, even if it has expired, until you unmount the backup.
• While mounting a remote mirror backup, if the corresponding primary mirror backup has already

been deleted, the mount request fails with a backup not found error.
• After you mount a backup, the time it takes to copy data from the datastore depends on your

network bandwidth and whether this datastore is on a secondary storage system.

How the Secondary Space Management wizard works
Before you use the Secondary Space Management wizard to plan and resolve your space
management issues, it is helpful to understand how the wizard works.

Summary of the wizard workflow
The wizard is iterative, which means that instead of moving through all the wizard pages in a linear
path, you move through some of the pages to plan a task for a selected volume. Then the wizard
returns you to the starting page to plan another task.

Appendix of additional information | 69



At any time in the iterative planning process, you can review your planned tasks to see the estimated
space savings in the aggregate. When you have planned all the tasks you want, you can have the
wizard implement all your planned tasks or choose to copy the plan to use later.

Summary of how to create a space management plan

1. Select a volume and task
The Volume and Tasks page displays information about the aggregate space usage, lists the
volumes in the aggregate and space usage information about each volume, and lists the tasks that
are allowed for the selected volume. You select a volume and the task that you want to plan.

2. Provide details for the task and view estimated space reclaimed
The wizard moves you through a series of pages that help you to enter specific information that is
needed to implement the task that you selected. On the Task Summary page, the wizard displays
the estimated amount of space in the aggregate that the task can reclaim.

3. View list of tasks planned and plan another task
When you click Next at the end of a task summary, the task is added to the space management
plan and the wizard returns to the Volume and Tasks page. The aggregate space usage
information is updated to reflect the projected results of the task you just planned. You can plan
as many tasks as you want by adding each additional task to the space management plan.

Summary of how to implement your space management plan

1. Review all tasks (and optionally revert a task)
When the estimated aggregate space usage resulting from your planned tasks reaches your goal,
you can click Review and Commit on the Volume and Tasks page. This option displays your
entire space management plan and the estimated total amount of space that will be reclaimed.
You can revert any of the planned tasks.

2. Implement all tasks
You can click Finish to have the wizard implement all the tasks in the plan. If you do not want to
implement the plan immediately, you can copy the list of tasks to your management station
clipboard and save it to re-create the space management plan at another time.

Role of protection policies in dataset management
A protection policy specifies a dataset's primary node, secondary node, and tertiary node data
protection topology, backup or mirror schedules, backup copy retention times, backup bandwidth
consumption, and other aspects related to backing up physical storage objects and virtual objects in a
dataset.

Direct or indirect assignment of a protection policy
Protection policies can be assigned to datasets directly or indirectly, through storage services.
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• You can assign protection policies directly to datasets that are configured to include and manage
physical storage objects as members.

• You can also assign protection policies to storage services, which are preconfigured combinations
of protection policies, provisioning policies, and resource pools.
You can then assign storage services directly both to datasets configured for physical storage
objects and datasets configured for virtual objects.

Where you can create, modify, and assign protection policies

You can create and modify protection policies, and assign them to storage datasets or storage
services using the associated program, NetApp Management Console. Information on any of those
tasks is in the NetApp Management Console help.

Requirements and restrictions when adding a dataset of
virtual objects

You must be aware of the requirements and restrictions when creating or editing a dataset of virtual
objects. Some requirements and restrictions apply to datasets of all types of virtual objects and some
are specific to datasets of Hyper-V or datasets of VMware virtual objects.

General requirements and restrictions

• OnCommand console administrators attempting to assign a storage service to a dataset, require
RBAC read permission (DFM.Policy.Read) to any protection policy included in that storage
service.
This is in addition to having RBAC permissions DFM.Policy.Read, DFM.StorageService.Read
and DFM.StorageService.Attach to the storage service itself.

• Administrators of datasets of virtual objects who are attempting to attach storage services to those
datasets require RBAC DFM.Resource.Control permission if the storage service they are
attempting to attach assigns a provisioning policy to the dataset primary node.
Even though provisioning policy assignment does not actually apply to datasets of virtual objects,
the DFM.Resource.Control permission is necessary to allow access to the underlying storage on
which the virtual objects are located.

• VMware objects and Hyper-V objects cannot coexist in the same dataset.
• Virtual objects (VMware objects or Hyper-V objects) cannot coexist in the same dataset with and

storage system container objects (such as aggregates, volumes, and qtrees).
• To provide an application dataset with application consistent backup protection, the OnCommand

console operator must assign to that application dataset a storage service that is configured with a
protection policy that uses a "Mirror then backup" type protection topology.

VMware specific restrictions

• VMware datacenter objects that you include in a dataset cannot be empty.
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They must contain datastore or virtual machine objects for successful backup.
• VMDKs on a datastore object in a dataset must be contained within folders in that datastore. If

VMDKs exist outside of folders on the datastore, and that data is backed up, restoring the backup
could fail.

Hyper-V specific restrictions

• A dataset with Hyper-V objects can only include virtual machines.
• Hyper-V objects and storage system container objects (such as aggregates, volumes, and qtrees)

cannot coexist in the same dataset.
• Shared virtual machines and dedicated virtual machines cannot coexist in the same dataset.
• Each virtual machine contained in the dataset that you want to back up must contain at least 300

MB of free disk space.
Each Windows volume in the virtual machine (guest OS) must have at least 300 MB free disk
space. This includes the Windows volumes corresponding to VHDs, iSCSI LUNs and pass-
through disks attached to the virtual machine.

What a dataset is
A dataset is a set of physical or virtual data containers that you can configure as a unit for the
purpose of group protection or group provisioning operations.

• You can use the OnCommand console to configure datasets that contain virtual VMware objects
or virtual Hyper-V objects.

• You can also use the OnCommand console and the associated NetApp Management Console to
configure datasets that contain physical storage systems with aggregates, volumes, qtrees, and
LUNs

During dataset configuration you can additionally configure or assign local protection or remote
protection arrangements and schedules that apply to all objects in that dataset. You can also start on-
demand protection operations for all objects in that dataset with one command.

Why datasets fail to conform to policy
A dataset must meet several conditions to be conformant to its assigned policy.

A dataset is conformant with its policy when it meets the following conditions:

• Its member storage systems are properly configured.
• Its assigned secondary storage system is provisioned and has enough backup space.
• Its protection policy includes all necessary relationships to enforce data backups or mirror copies.

Following are some of the common reasons datasets fail to conform to their protection policy:

• Dataset storage service and protection policy definitions changed.
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• Dataset membership changed.
• Volumes or qtrees were created or deleted at the storage system (external to the OnCommand

console).
• The configuration of a dataset of virtual objects has been updated, but not yet communicated from

the DataFabric Manager server to the host service.
This nonconformance condition normally lasts only a few minutes until the DataFabric Manager
server updates the host service with the latest configuration.
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